Budget Execution Data Entry Guide

Chapter 8. Assignment/Operating Budget

A.  Processing an Assignment/Operating Budget (SA) Document

The Assignment/Operating Budget document distributes budget authority by
Budget Fiscal Year (BFY), fund, allotment holder, program/object class, program,
organization and budget object code. Distribution by budget object code (BOCT) is
optional. One document is used to record distributions to organizations for both
administrative and program funds as follows:

u Assignment/Operating Budget (SA)
1. Verify Fund Availability with the Distribution to Program Query
(ALLT)

To verify fund availability, scan the Distribution to Program Query (ALLT)
before processing an Assignment.

The Distribution to Program Query (ALLT) is used to review information
about the status of an allotment, including the allotted, committed, and
expended amounts.
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a. The Distribution to Program Query (ALLT) is displayed as follows:
(1) Select Options from the Main menu.
(2) Select Tables and Queries from the Options menu.

3) Click on the Category drop-down list and select Budget
Execution.

4) Select the Distribution to Program Query (ALLT).

@) Choose the OK button.

= Distribution to Program Query [ALLT] ~| =~

® Budget Fiscal Year[s): |:||:| % Fund: I:l (S ? Drganization: |:|
T Allotment Holder: [ | FPomsObiCls: [ | FObjectCode: [ |

I| Dristribution I| Spending I

Transaction Types —— | Budget Amounts
[] Active Pending: Approved Dizstribution:
[] Approved Approved: YTD Distribution to Pgm:
Posted:
Reimbursements Spending Amounts
E stimated: Unliquidated Commitments:
Undizstributed: Undehivered Obligations:
Actual: Expenditures:
Transzaction Code: Tranzaction Type:
Spending Control Override :
® Mo Override ' Full Control ) Presence Control YTD Available:

Fundsz Available thru Quarter:

(6) Enter the Budget Fiscal Year(s) in the Budget Fiscal Year(s)
field (for a multi-year fund, enter the last two digits of the
beginning year and the last two digits of the ending year), the
fund code in the Fund field the allotment holder in the
Allotment Holder field, and the program code in the Pgm/Obj
Cls field.

(7) Select Actions from the Main menu.

8) Select Display from the Actions menu.

Refer to Appendix A for example of populated document. See Example A-12.A.
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) Click on the Distribution tab to view the quarterly
Distribution to Program and Quarterly Distributions to
Assignment/ Operating Budget to verify the amount
available for further distribution. Additional assignments can
be issued for amounts equal to or less than the undistributed
balances.

= Distribution to Program Query [ALLT] e

¥ Budget Fiscal Year(s): ][ | FFund: [ ] &, P Organization: [ |
T Allotment Holder: [ | FPomsObiCls: [ | FObjectCode: [ |

Surnmary I Q

Distribution to Program

I| Spending I

Quarter Original Pending Approved
1

2
3
4

Quarterly Distributions to Aszignment/0perating Budget

Quarter Distributed Undistributed
1

2
3
4

Refer to Appendix A for example of populated document. See Example A-12.B.
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2. Assignment/ Operating Budget (SA) Document

a. Perform the following steps to process an Assignment/Operating
Budget document:

(1) Select File from the Main menu.
(2) Select New from the File menu.

3) From the Document drop-down list box, select Assignment/
Operating Budget (SA).

4) Enter the Document ID.

Note All SA document IDs referencing a no-year or multi-year fund code include the allotment holder
(ex: CFO, HSNG, CPD, PIH, etc.) in the first field. The last digit of the current fiscal year, the
third and fourth digit of the fund code and the # sign are included in the second field (Example:
HSNG OHA#). The SA Document ID referencing an annual fund includes the last digit of the
current fiscal year, the last 4 digits of the Treasury symbol and the # sign in the second field
(Example: CFO 00143#). By entering the # sign, the system will assign the next available
sequential number for the document ID prefix entered.

I Open Document{Batch I

Document: | Assignment{Operating Budget [SA) |_;|

Batch ID: | || |

Document 1D: || || | 1] 4

Security Org: | |

@) Select OK or press the Enter key.
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b.

|

Enter the following fields on the Header tab:
Batch: Document: 3A CPD 0HADODDDDO0O1 Status: NEVW 'l‘
Header || BudgetLinels) || FIELinels) |
Tranzaction Date: |:|:' |:|J'|:|
Federal Fizcal Mo/ |:|:'|:|
Budget Fizcal Year[s]: |:||:| Fund: I:l &

Total Revised Assignment/Op. Budget: [ |
Total Revised Assigned FTEs: [ |

Pending Transaction Type: I:l
Approved Transaction Type: I:l
Posted Transaction Type: I:l
Posted Through Quarter: ||
Pending/Approved/Post Indicator: I:l
D efault Estimated Reimbursement Tranzaction Type: I:l

Field

Description

@)

Budget Fiscal Year(s)

Enter the last two digits of the Budget Fiscal Year(s). For
a multi-year fund, enter the last two digits of the
beginning year and the last two digits of the ending year.

Assignment/Op. Budget

(2) Fund Enter the fund code, or click on the search icon for a
listing of valid fund codes.
(3) Total Revised Enter the sum of the Assignment/ Operating Budget. This

field must equal the sum of all amounts entered on the
Budget Line(s) tab.

(4) Pending Transaction Type | Enter PN.

(5) Approved Transaction Enter AP.
Type

(6) Posted Transaction Type Enter 01.

()

Posted Through Quarter

Enter 1, 2, 3, Or 4 for the quarter thru which funds are
available

©)

Pending/Approved/Post
Indicator

Enter DP.

Refer to Appendix A for example of populated document. See Example A-7.A.
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C.

Select the Budget Line(s) tab and enter the following fields:

= Batch: Document: 3A CPD 0HADODDDDO0O1 Status: NEVW 'l‘
Header I Budget gne[s]I | FTE Line(s) I
[+
Budget Line Action
#® AddsActivate (0 Change () Deactivate { Default  Assignment/Op. Budget Level: [ |
Budget Type Budget Elements
@] ¢ FTEs 2 Dollars and FTEs () Default Allotment Holder: [ |
Organization From: |:|
Spending Control Override
: ization To: [ |
@ Mo Override ¢ Full Control ) Presence Control Brasaizationtlo
Program/0bj Cls: I:|
Aszzignment/0p. Budget Distribution )
DObject Code:
Quarter Pending Inc/Dec (B :l
1] | | | Estimated Reimbursements
2 | | | | Revized Amount: I:|
3 | | | | Inc/Dec Amount: [ |
I | | | Tranzaction Type: I:l
Description: | |
+]
Field Description

1)

Budget Line Action

Budget Line Action defaults to Default. Select
Add/Activate if this is the first SA document for this
budget line. Select Change if previous SA documents
have been processed for this budget line.

Code

(2) Budget Type Budget Type defaults to Default. Select Dollars as the
budget type.
(3) Assignment/Op. Budget Enter 01, 02, or 03 as appropriate.
Level
(4) Budget Elements Allotment | Enter a valid division code to represent the allotment
Holder holder. Valid codes can be found on the Division Table
(DVSN).
(5) Budget Elements For Assignment/Op. Budget Levels 2 and 3, enter the
Organization From organization code of the issuer of the
assignment/operating budget. The referenced
organization must have already received an assignment
from its parent organization.
(6) Budget Elements Enter the valid organization code of the authorized
Organization To recipient of the assignment/ operating budget from the
Organization Table (ORGN).
(7) Budget Elements Enter the appropriate program code. Valid codes can be
Program/Obj Cls found on the Program Code Table (PGMT).
(8) Budget Elements Object Enter a valid object code from the Budget Object Code

Table (BOCT) if this option is required by the recipient of
the Distribution to Program.
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Field Description
(9) Assignment/Op. Budget Amounts must be entered as dollars and cents with a
Distribution Quarter decimal. Decrease amounts must be preceded with a
Inc/Dec minus sign (-). Apportion all program funds in quarter 1,

and distribute administrative funds by the applicable
quarters. The sum of this field must match the amount
entered on the Header tab.

Refer to Appendix A for example of populated document. See Example A-7.A.

Note No data needs to be entered on the FTE Line(s) tab.

(10) Select Document from the Main menu.
(11) Select Edit from the Document menu.

(12) View the message area at the bottom of the window for warning or error
messages and make the necessary changes.

Note If an error message occurs, use the Online Error Guide by double clicking on the error message.
If unable to resolve the error with the Online Error Guide, call the HUDCAPS Help desk.

(13) Select Document from the Main menu.
(14) Select Process from the Document menu.
(15) When the message, “ The document has been accepted, do you want to

close the document?’ appears, select Yes to close the document, or No
to keep it open.
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Assignment Spending Control Query (SASP)

The Assignment Spending Control Query (SASP) is used to review
information about the status of an assignment/operating budget in total,
which includes all assignments to levels 2 and 3, if any. View this query after
processing an SA document to ensure that funds have been distributed as
intended.

a. The Assignment Spending Control Query (SASP) is displayed as
follows:

(1) Select Options from the Main menu.
(2) Select Tables and Queries from the Options menu.

3) Click on the Category drop-down list and select Budget
Execution.

4) Select the Assignment Spending Control Query (SASP).

@) Choose the OK button.

= Assignment Spending Control Query [SASP) -~
® Budget Fiscal Year(s): D:“:l % Fund: I:l (S % Drganization: |:|
? Allotment Holder: [ | % Pgm/0bj Cls: I:| % Object Code: I:l

J Summary I | Spending I | FTEs I

[ Active Budget Amounts

O Approved Azzsignment:
Approve

Posted Through Quarter:

Y¥TD Azzignment:

Spending Amounts
Transaction Code: Unliquidated Commitments:

Pending Transaction Type: Undelivered Obligations:

Approved Transaction Type: Expenditures:

Posted Transaction Type:
YTD Awailable:

Spending Control Overnide
@ Mo Dvemnide

¢ Full Control

" Presence Control

(6) Enter the Budget Fiscal Year(s) in the Budget Fiscal Year(s)
field (for a multi-year fund, enter the last two digits of the
beginning year and the last two digits of the ending year), the
fund code in the Fund field, the organization in the
Organization field, the allotment holder in the Allotment
Holder field, the program code in the Pgm/Obj Cls field, and
the Budget Object Code in the Object Code field, if applicable.
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(7) Select Actions from the Main menu.
8) Select Display from the Actions menu.

) View the fund availability in the YTD Available field.

Refer to Appendix A for example of populated document. See Example A-13.A.

4. Assignment Operating Budget Query (SAIN)

The Assignment Operating Budget Query (SAIN) is used to review
information about the status of a specific assignment/operating budget level,
which includes levels 1, 2 and 3. View this query after processing an SA
document to ensure that funds have been distributed to the proper level as
intended.

a. The Assignment Operating Budget Query (SAIN) is displayed as
follows:

(1) Select Options from the Main menu.
(2) Select Tables and Queries from the Options menu.

3) Click on the Category drop-down list and select Budget
Execution.

4) Select the Assignment Operating Budget Query (SAIN).

@) Choose the OK button.

= Assignment/Operating Budget Query [SAIN] -«

? BFY(): D:“:l T Level |:| % Fund: I:l (S % Allotment Holder: |:|
% 01ganization: |:| % Pam/0bj Cls: I:| ? Object Code: :|

J Summary I| Distribution I| Spending I

Budget Amounts [This Level]

[ Active Approved Assignment:

[] Approve
Posted Through Quarter:

YTD Assignment:

Spending Amounts [This Level]
A I U i L e Unliquidated Commitments:

Approved Transaction Type: Undelivered Obligations:
Posted Transaction Type: E I
xpenditures:

YTD Awailable:
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(6) Enter the Budget Fiscal Year(s) in the Budget Fiscal Year(s)
field (for a multi-year fund, enter the last two digits of the
beginning year and the last two digits of the ending year), the
level of the assignment in the Level field, the fund code in the
Fund field, the organization in the Organization field, the
allotment holder in the Allotment Holder field, the program
code in the Pgm/Obj Cls field, and the Budget Object Code in
the Object Code field, if applicable.

(7) Select Actions from the Main menu.
8) Select Display from the Actions menu.

) View the fund availability for the specific assignment level
being viewed in the YTD Available field.

Refer to Appendix A for example of populated document. See Example A-14.A.

(10)  Select the Distribution tab to view Quarterly Assignment/Op
Budget (This Level) and Quarterly Distributions Lower
Level Assignments) to verify the amount available for
spending. Additional assignments can be issued for amounts
equal to or less than the undistributed balances.

= Assignment/Operating Budget Query [SAIN] -«

T BFY(s): |:||:| % Level |:| % Fund: I:l Q % Allotment Holder: |:|
? Organization: [ | % Pogm/ObiCls: [ ] % Object Code: [ |

Surmmary I I| Spending I

Quarterly Assignment/0p. Budget [This Level]

Quarter Original Pending Approved
1

2
3
4
Quarterly Distributions [Lower Level Assignments]

Quarter Digtributed Undiztributed
1

2
3
4

Refer to Appendix A for example of populated document. See Example A-14.B.
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